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Accompanying Class Files

This manual comes with accompanying class files, which your instructor or sales
representative will point out to you. Most code samples and exercise and solution
files found in the manual can also be found in the class files at the locations indicated
at the top of the code listings.

Due to space limitations, the code listings sometimes have line wrapping, where
no line wrapping occurs in the actual code sample. This is indicated in the manual
using three greater than signs: >>> at the beginning of each wrapped line.

In other cases, the space limitations are such that we have inserted a forced line
break in the middle of a word. When this occurs, we append the following symbol
at the end of the line before the actual break: »»
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SharePoint 2013 Introduction1.

In this lesson, you will learn...

1. About the versions of SharePoint.
2. About SharePoint site hierarchy.
3. About Team Site layout.
4. About navigation within a Team Site.

SharePoint 2013 is a collaboration tool at its heart. Its primary goal is to make it
easy for users to find and share information, and there are many features built into
SharePoint to facilitate this. SharePoint's library system feature can provide a superior
alternative to the traditional file server. SharePoint lists can be an easy-to-design
and easy-to-use alternative to sharing spreadsheet files or more formal database
tables. Both lists and libraries can be customized and extended to provide enhanced
appearances and functionality, such as calendars and discussion boards, to name a
couple. All of this collaboration can be done through a browser interface and in
some cases through integration with Microsoft Office applications.

SharePoint Versions1.1

SharePoint 2013 is available in three on-premise versions in addition to packages
hosted by Microsoft. This course will focus on the on-premise versions of SharePoint.
Of the on-premise versions there is the free version, SharePoint Foundation, and
two versions that require the purchase of licenses, Standard and Enterprise. The
differences between the three versions are based on the features they offer.

SharePoint Foundation's features are, as the name implies, core features in both
Standard and Enterprise. Standard has additional features added to what is provided
by Foundation. Enterprise has additional feature added to both the features from
Standard and Foundation.

The scope of this course is for the "end user" and most of the features that fall within
that scope come with Foundation.

Team Site Layout and Navigation1.2

Layout

SharePoint sites are part of a hierarchy that is grouped in a Site Collection. There
is always one site that is the root site of the Site Collection but below that site can
be many child sites. Lists and Libraries can be created within each site in the Site
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Collection. The Site Collection defines the basic storage as well as administration
and permissions. In a later lesson in this course, you will explore the basic
permissions and how they are applied to each site within the Site Collection as well
as each list and library.

The following diagram illustrates a conceptual view of how sites might be organized
in a Site Collection. Note that the presentations in this course use a root site named
Contoso Home Site with a single child site named Sub Site A.

Navigation

Navigation is a crucial part of using and managing SharePoint. The following
walk-through, will navigate the root Team Site named Contoso Home Site as well
as its single child site Sub Site A. The walk-through will highlight different menus
and navigation links shared by all the pages in a SharePoint site.
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1. Navigate to your team site.
A. Launch whatever browser you prefer; the examples in this course use

Internet Explorer.
B. Type the address of your team site; the examples in this course use

http://spserver2013/sites/student00.
C. The home page of your team site should look similar to the following:

2. Navigate using the Top Link Bar.
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A. The site you are located in can be verified by the Title:

The title of the walk-through site is Contoso Home Site and the Home
tab is shaded in the Top Link Bar of the site.

B. Click a link in the site's Top Link Bar, other than Home, to navigate to
the home page of the child site. In this walk-through the child site is titled
SubSite A.

Note that links in the Top Link Bar are not necessarily child sites, they
can be links that have been manually created and that navigate to pages
within the root site. The default behavior when adding a new child site to
a parent site is to add a link to the Top Link Bar of the parent site.
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C. Note how the Title of the child site is shown in the following image.

Sometimes it can be hard to tell that you are on a different site. In this
walk-through both sites' home pages and Quick Launch menus are based
on the same Team Site templates, and neither have had any customizations
performed on them. The only visual differences at this point are the titles
Sub Site A and Contoso Home Site, and Sub Site A only has the Home
link in its Top Link Bar because it does not yet have any child sites. In a
later part of this course, you will learn how modify the content of pages
such as the home page. You will also be adding content to the site that
will automatically change the Quick Launch menu.
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3. Navigate back to the parent site.
A. Use the Back button of your browser to navigate back to the parent site.

In a later part of this course, you will learn how to configure child sites
to use the same Top Link Bar as their parent site as well as how to add
custom links.
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4. Navigate using the Quick Launch menu.
A. Select the Documents inside the Quick Launch menu located on the left

side of the page.
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B. Navigate back to the home page of the site by clicking the Home link
within the Quick Launch menu.

In later parts of this course, you will learn how to create lists and libraries
as well as other items that will automatically add links to the Quick Launch
menu. You will also explore how to customize the Quick Launch menu
manually.
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5. Navigate using the Settings menu.
A. Click the Settings menu located at the top right of your Team Site.

B. Take a few moments to read through the list of links in the Settings menu.
The items you see in the list reflect who you are logged into the site as.
The list uses security trimming to show only items that you have
permission to use.

In a later part of this course, you will learn how to assign permissions.

6. Navigate using Bread Crumb Navigation.
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A. Click Documents on the Quick Launch area.

B. Click on a folder name, such as Project Files.
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C. Navigate back to main Document Library by following the Bread Crumb
Navigation.

Customize Quick Launch

The Quick Launch navigation is a great place for detailed links in a specific site.
This area can be customized to show links to other SharePoint sites, objects in the
current site, or links to any outside public facing sites.
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1. Settings > Site Settings.

2. Look and Feel > Quick Launch.

3. Choose one of the options to customize.

• New Navigation Link: Creates a new individual link that is organized in
an existing Heading.

• New Heading: Create the new Heading in which to categorize the
individual links.

• Change Order: Set the order top to bottom of each heading, and the
individual links within each.
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Team Site NavigationExercise 1
15 to 25 minutes

In this exercise, you will learn to navigate a basic SharePoint 2013 Team Site.
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1. Navigate to your team site.
A. Launch Internet Explorer.
B. In the address field, enter the address: "http://<<insert your site here>>".
C. The home page for your team site will load and look similar to the

following:

2. Navigate using the Top Link Bar.
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A. Verify that you are currently located on the home page of your Team Site,
the Contoso Home Site link should be shaded blue in the Top Link Bar
of the site.

B. Click the link of a child site such as SubSite A located in the site's Top
Link Bar.
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C. Verify that you are now located on the home page of the child site by
checking the Title displayed for the site.

It might be hard to tell that you are on a different site. Both sites' home
pages and Quick Launch menus are could be based on the same Team
Site templates, and you have not made any customizations to either. The
only visual differences at this point are the titles such as SubSite A and
Contoso Home Site in the screen captures, and in the example Sub Site
A only has its title link in the Top Link Bar because it does not as of yet
have any child sites. In a later part of this course, you will modify the
content of pages such as the home page. You will also be adding content
to the site that will automatically change the Quick Launch menu.
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3. Navigate back to the parent site.
A. Use the Back button of your browser to navigate back to the parent site.

In a later part of this course, you will learn how to configure child sites
to use the same Top Link Bar as their parent site as well as how to add
custom links.
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4. Navigate using the Quick Launch menu.
A. Select the Documents inside the Quick Launch menu located on the left

side of the page.

© Copyright 2014 Webucator. All rights reserved.Page 18 of 473

SharePoint 2013 Introduction

EVALUATION COPY 

 
 

Unauthorized Reproduction or Distribution Prohibited



B. Navigate back to the home page of the site by clicking the Home link
within the Quick Launch menu.

In later parts of this course, you will learn how to create lists and libraries
as well as other items that will automatically add links to the Quick Launch
menu. You will also explore how to customize the Quick Launch menu
manually.

5. Navigate using the Settings menu.
A. Click the Settings menu located at the top right of your Team Site.
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B. Take a few moments to read through the list of links in the Settings menu.
The items you see in the list reflect who you are logged into the site as.
The list uses security trimming to show only items that you have
permission to use.

In a later part of this course, you will learn how to assign permissions.
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Conclusion1.3
In this lesson, you have learned:

• About the different versions SharePoint offers.
• About the basic hierarchy of a Site Collection.
• About the basic menus and toolbars in a Team Site.
• How to navigate within a Team Site.
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Office Integration9.

In this lesson, you will learn...

1. How to create a list from an Excel spreadsheet.
2. To update a spreadsheet view of SharePoint list data.
3. How to create an alert.
4. How to subscribe and view an RSS feed from a SharePoint list.
5. How to make a copy of a library in Outlook.
6. How to use the Datasheet view.
7. How to open and edit a list in Access.

One of the nice features of SharePoint is its ability to integrate with Microsoft Office
applications. Just about every Office application offers some level of integration
with SharePoint whether it be simple, such as using an Excel spreadsheet to create
a new list, or more full featured, such as Outlook integration. Some integration
features enhance what is available online through a browser while others allow
access to SharePoint content offline such as a mobile computer environment. This
lesson will use a series of walk-throughs and exercises to show how each Office
application can integrate with SharePoint.

Excel Integration9.1

Import Excel Spreadsheet to List

This walk-through will show you how to import data from an Excel spreadsheet and
create a new SharePoint list.
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1. Create a new list by using the Import Spreadsheet template.
A. Click the Settings menu and then choose the Add an app link.

B. Locate the Import Spreadsheet App template and click the link.
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C. In the new list form that opens enter Golf Clubs in the Name field
and
List of golf clubs and their average loft angle and distances
in the Description field.

D. Click the Browse button to select the spreadsheet for the import.
E. In the Choose File to Upload dialog window, browse to the folder you

downloaded the class files to and select the club-specs.xlsx file. Click the
Open button to close the dialog window and complete the selection.

F. Click the Import button. This should open Microsoft Excel with the
selected file loaded. A second dialog window titled
Import to Windows SharePoint Services list should also open as shown
in the following image.
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G. In the Range Type drop-down, select Named Range and in the
Select Range drop-down field choose ClubData from the list.

Optionally you could choose Range of Cells from the Range Type field.
This would then allow you to use your mouse to click and drag across
your spreadsheet selecting the range of cells to import. Having a named
table as you do in this example makes it a bit easier to just select the table.

H. Click the Import button to complete the import process.
2. Add the new imported list to the Quick Launch menu.

A. Note how the new list "Golf Clubs" does not have a link in the
Quick Launch menu. The Import Spreadsheet template you used does
not have an option to add the list to the Quick Launch menu as part of
the import and creation process.

B. Click on the List tab to open the toolbar and click the List Settings link
button.
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C. Click the List name, description and navigation link under the
General Settings group on the List Settings page.

D. Click the Yes option under the section
Display this list on the Quick Launch? and then click the Save button
to save your changes.

E. Note how now there is a new link Golf Clubs under the Lists group within
the Quick Launch menu.

The text for the link in the Quick Launch menu is based on the title of
the list. The lists title can be changed on the Site Settings page using the
same List name, description, and navigation link used to add the list to
the Quick Launch.

Export List Data to Excel

This walk-through will show you how to export the list data from the Golf Clubs
list to an Excel spreadsheet. It does not matter that the data originally came from an
Excel spreadsheet; you could perform these steps on any list. The walk-through does
require that you have done the previous walk-through to create the Golf Clubs list.
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1. Export the Golf Clubs list to Microsoft Excel.
A. Open your browser if it is not already open and navigate to your root team

site.
B. Click the Golf Clubs link in the Quick Launch menu to navigate to the

list.

C. Click the List tab to open the toolbar.

D. Click the Export to Excel in the Connect & Export area of the List tab
toolbar.

E. Click the OK button on the Message from Webpage notifying you about
a compatible application
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F. In the Open or Save dialog, click the Open button to open the owssvr.iqy
file.

The image shows the dialog you get from IE 9 and 10.

G. Click the Enable button on the Microsoft Excel Security Notice dialog
window to enable the data connection back to the SharePoint server.
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H. Microsoft Excel will open with the Golf Clubs list data in a linked
spreadsheet. Note that the link is one way. You can only get updates from
the SharePoint server, and any changes you make to the spreadsheet data
do not sync back to the list in the site.

2. Create a chart of the Favorite Cars list data.
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A. Inside the Excel spreadsheet, select the Club Name column heading then
click and drag your mouse over the data and stop on the Fast Swing Yards
column and the last row. The selected region should look like the following
image. Note that you are including the column headings in our selection.

B. With the two data columns selected, click the Insert tab on the Excel
toolbar.
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C. Click the Line drop-down menu in the Charts region of the Excel Insert
tab toolbar and click the first 2-D Line option.

D. There should now be a 2D line chart of the Golf Clubs data displayed in
the center of your spreadsheet.

3. Update the Golf Clubs list data and sync the updates to the linked Excel
spreadsheet.
A. Go back to your browser window with the Golf Clubs list All Items view

showing.
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B. Click the Driver link to open the item's properties form.

C. Click the Edit Item link on the Driver properties form.
D. Change the Fast Swing Yards field of the Driver to "325" and click the

Save button to save the change.

E. Click back in your Excel window to bring the it back to the foreground.
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F. Click the DATA tab in Excel to open the toolbar.

G. Click the Refresh All button in the Connections region of the Data tab
toolbar.

H. The Excel spreadsheet and chart should now reflect the changes we made
to the list.

I. Close Microsoft Excel and click Don't Save when asked if you want to
save the changes to 'Book1'.
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Outlook Integration9.2

Create an Alert

This walk-through will show you how to create an alert in the Golf Clubs list to
notify you when the list is changed. The demonstration requires that you have done
the earlier demonstration that created the Golf Clubs list.

This walk-through will only work if your SharePoint server is configured with an
email server it can deliver to and the account you are logged in with has a valid
email address.
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1. Create an alert for the Golf Clubs list.
A. Open your browser if it is not already open and navigate to your root team

site.
B. Click the Golf Clubs link in the Quick Launch menu to navigate to the

list.

C. Click the List tab in the List Tools toolbar.

D. Click the Alert Me drop-down button in the Share & Track region on
the List Tools List tab toolbar and select the Set alert on this list option.

The Alert Me button only displays if the Farm administrator has
configured the server with an outgoing mail server address.
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E. Leave all the default options in the Golf Clubs - New Alert dialog form
and click the OK button to save the new alert.

2. Add a new Golf Clubs item to the list to test the new alert.
A. Click the new item link at the top of the list.
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B. Enter the following values for new Favorite Car item and click on the Save
button to save the data back to the list.

Fast Swing YardsMedium Swing YardsLoft DegreesClub Name

807555Sand Wedge

3. Check for an alert in Microsoft Outlook 2013.
A. Launch Microsoft Outlook 2013.
B. You will eventually have two emails in your Inbox generated by the alert

system. It could take up to 10 minutes for them to appear due to a delay
in the SharePoint service responsible for generating emails even with the
alert option set to Send notification immediately.

Subscribe to a List's RSS Feed

This walk-through will show you how to subscribe to the RSS (Really Simple
Syndication) feed generated by the Golf Clubs list. The alert in the previous
walk-through can become an annoyance with a lot of changes occurring and emails
being generated. A less intrusive way of keeping up to date on lists would be to use
RSS. This walk-through requires the Golf Clubs list created in the first walk-through
in this lesson.
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1. Subscribe to an RSS feed in the Golf Clubs list.
A. Click the Golf Clubs link in the Quick Launch menu to navigate to the

list.

B. Click the RSS Feed button in the Share & Track region on the List Tools
List tab toolbar.

C. Click the Subscribe to this feed on the Favorite Cars RSS feed page.

D. Click Yes in the Add this RSS Feed to Outlook dialog window to
complete adding this RSS subscription to the Common Feed List.
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E. Click the link at the top of the RSS feed page to navigate back to the
SharePoint site.

2. View the Golf Clubs RSS feed in Microsoft Outlook 2013.
A. Go back to our Outlook window and click on the RSS Feeds link in the

side bar menu.

B. Verify that your RSS Feed is now showing the latest changes to the
Golf Clubs list. You can test this further by modifying or creating a new
item in the Golf Clubs list.

Connect to Outlook

This walk-through will show you how to connect a library to Outlook. Using the
Connect to Outlook feature in SharePoint allows you to have a copy of a library
and certain lists in Outlook that you can work with offline. This walk-through uses
the Work Orders library that was created in a previous walk-through in the "Site
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Columns and Content Types" lesson but the same steps can be performed on any
library.

1. Connect the Work Orders library to Outlook.
A. Click the Work Orders library on the root site's Quick Launch menu.

If Work Orders is not listed under the Recent group in the Quick Launch
menu it might be listed under Site Contents. The Recent list only displays
the last five lists or libraries created.

B. Click the Connect to Outlook icon in the Connect & Export region on
the Library tab toolbar.

Depending on the width of your browser screen, you may or may not see
the label text "Connect to Outlook".
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C. In the Internet Explorer dialog window that asks,
Do you want to allow this website to open a program on your computer?,
click the Allow button.

D. In the Microsoft Outlook dialog window that asks, "Connect this
SharePoint Document Library to Outlook?", click the Yes button.

E. A new SharePoint Lists tree menu will be added to your Outlook side
bar menu with the Work Orders added and opened. Outlook can now be
used to view, create, and edit items in the Work Orders library.
Additionally you can work offline with this library through Outlook.
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Access Integration9.3

Open a List with Access

In this walk-through you will learn how to open a SharePoint list in Access. Unlike
exporting to Excel, we can both read and update list data from Access. This
walk-through uses the Golf Clubs list created as part of an earlier walk-through.

1. Open the Golf Clubs list in Microsoft Access.
A. Open your browser if it is not already open and navigate to your root team

site.
B. Click the Golf Clubs link in the Quick Launch menu to navigate to the

list.

C. Click the LIST tab to open the toolbar.
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D. Click the Open with Access icon in the Connect & Export region on the
LIST tab toolbar.

Depending on the width of your browser screen, you may or may not see
the label text "Open with Access".

E. Leave the default settings and click the OK button in the
Open in Microsoft Access dialog window.
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F. In the Microsoft Access window that opens, double-click the Golf Clubs
link in the Tables window to open it and view the data.
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G. Modify the Driver's Fast Swing Yards to be "275". Click the Refresh All
button in the Home tab on Access's toolbar.

The ribbon message with the Save Changes warning icon and the
Save to SharePoint Site button is deceiving. That button will save a new
Access database file back to a library on your SharePoint site; it will not
save your changes back to the original list.

H. Go back to your browser window and refresh the Golf Clubs page. The
Driver item in the browser window should now match what you changed
it to in Access.

I. Try editing the Driver Fast Swing Yards in the browser back to "350"
and saving it. Go back to the Access window and click the Refresh All
button in the Home tab and verify that Access now displays "350" for the
Driver Fast Swing Yards.

J. Close Access when you are done trying out the editing and synchronizing.
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Excel IntegrationExercise 18
15 to 25 minutes

In this exercise, you will learn how to export a SharePoint 2010 list to Microsoft
Excel.
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1. Export the Favorite Cars list to Microsoft Excel.
A. Open your browser if it is not already open and navigate to your root team

site.
B. Click the Favorite Cars link in the Quick Launch menu to navigate to

the list.

If Favorite Cars is not listed under the Recent group in the Quick Launch
menu it might be listed under Site Contents. The Recent list only displays
the last five lists or libraries created.

C. Click the Export to Excel in the Connect & Export area of the List tab
toolbar.
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D. In the Open or Save dialog, click the Open button to open the owssvr.iqy
file.

The image shows the dialog you get from IE 9 or 10.

E. Click the Enable button on the Microsoft Excel Security Notice dialog
window to enable the data connection back to the SharePoint server.

F. Microsoft Excel will open with the Favorite Cars list data in a linked
spreadsheet. Note that the link is one way. You can only get updates from
the SharePoint server; any changes you make to the spreadsheet data do
not sync back to the list in the site.
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2. Create a chart of the Favorite Cars list data.
A. Inside the Excel spreadsheet, select the data in both the Model and

Top Speed columns by clicking and dragging your mouse over both
columns of data.

B. With the two data columns selected, click the Insert tab on the Excel
toolbar.

C. Click the Bar drop-down menu in the Charts region of the Excel Insert
tab toolbar and click the 3-D Bar option.
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D. There should now be a 3-D chart of the Favorite Cars top speeds displayed
in the center of your spreadsheet.

3. Update the Favorite Cars list data and sync the updates to the linked Excel
spreadsheet.
A. Go back to your browser window with the Favorite Cars list All Items

view showing.
B. Click the Ferrari 458 Italia link to open the item's properties form.

C. Click the Edit Item link on the Ferrari properties dialog form.
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D. Change the Top Speed field of the Ferrari to "300" and click the Save
button to save your change.

E. Click back in your Excel window to bring it back to the foreground.
F. Click the DATA tab in the Excel toolbar.

G. Click the Refresh All button in the Connections region of the DATA tab
toolbar.
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H. The Excel spreadsheet and chart should now reflect the changes you made
to the list.

I. Close Microsoft Excel and click Don't Save when asked if you want to
save the changes to 'Book1'.
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Outlook IntegrationExercise 19
15 to 25 minutes

In this exercise, you will learn how to use Outlook with your SharePoint site.

1. Create an alert for the Favorite Cars list.
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This alert exercise will work only if your SharePoint server is configured with
an email server it can deliver to and the account you are logged in with has a
valid email address.

A. Open your browser if it is not already open and navigate to your root team
site.

B. Click the Favorite Cars link in the Quick Launch menu to navigate to
the list.

C. Click the List tab to open the toolbar.
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D. Click the Alert Me drop-down button in the Share & Track region on
the List Tools List tab toolbar and select the Set alert on this list option.

The Alert Me button only displays if the Farm administrator has
configured the server with an outgoing mail server address.
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E. Leave all the default options in the Favorite Cars - New Alert dialog
form but take a moment to read the options and their descriptions. Click
the OK button, once you are done scanning the options, to save the new
alert.

2. Add a new Favorite Cars item to the list to test the new alert.
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A. Click the new item link at the top of the list.

B. Enter the following values for new Favorite Car item and click on the Save
button to save the data back to the list.

PriceTop SpeedModelMake

196,800.00198R8Audi

3. Check for an alert in Microsoft Outlook 2013.
A. Launch Microsoft Outlook 2013.
B. You will eventually have two emails in your Inbox generated by the alert

system. It could take up to 10 minutes for them to appear due to a delay
in the SharePoint service responsible for generating emails, even with the
alert option set to Send notification immediately.

If the alert message has not arrived in your Inbox yet, you may wish to
continue to the next step in this exercise and check back later.

C. Leave Microsoft Outlook open for the next step in this exercise.
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4. Subscribe to an RSS feed in the Favorite Cars list.
A. Go back to your browser window with the Favorite Cars list All Items

view showing.
B. Click the RSS Feed button in the Share & Track region on the List Tools

List tab toolbar.

C. Click the Subscribe to this feed on the Favorite Cars RSS feed page.

D. Click Allow in the Internet Explorer dialog asking if you want to allow
this website to open a program on your computer.
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E. Click Yes in the Microsoft Outlook dialog asking if you want to "Add
this RSS Feed to Outlook".

F. Click the link at the top of the RSS feed page to navigate back to the
SharePoint site.

5. View the Favorite Cars RSS feed in Microsoft Outlook 2013.
A. You will see an arrow next to the RSS Feeds link in the side bar menu.

Click on the arrow to expand it and select the Favorite Cars link within
it.

B. It might take a while before Outlook will automatically synchronize with
the RSS feed. To force it to update, click on the Send/Receive tab in
Outlook and click the Update Folder link.

C. Verify that your RSS Feed is now showing the latest changes to the
Favorite Cars list. You can test this further by modifying or creating a
new item in the Favorite Cars list. If you do, follow the previous step to
force Outlook to refresh the RSS feed folder. Leave Outlook open for the
next step in this exercise.

6. Connect the Documents library to Outlook.
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A. Go back to your browser window and click the Documents library on the
root site's Quick Launch menu.

B. Click the Connect to Outlook icon in the Connect & Export region on
the Library tab toolbar.

Depending on the width of your browser screen, you may or may not see
the label text "Connect to Outlook".
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C. In the Internet Explorer dialog window that asks you "Do you want to
allow this website to open a program on your computer?", click the Allow
button.

D. If you get the Internet Explorer Security dialog window warning you
about "A website wants to open Web content using this program on your
computer", click the Allow button.
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E. In the Microsoft Outlook dialog window that asks you "Connect this
SharePoint Document Library to Outlook?", click the Yes button.

F. A new SharePoint Lists tree menu will be added to your Outlook side
bar menu with the Documents added and opened. Outlook can now be
used to view, create, and edit items in the Documents library. Additionally,
you can work offline with this library through Outlook.
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Access IntegrationExercise 20
15 to 25 minutes

In this exercise, you will learn how to use Microsoft Access with your SharePoint
site.

1. Open the Favorite Cars list in Microsoft Access.
A. Open your browser if it is not already open and navigate to your root team

site.
B. Click the Favorite Cars link in the Quick Launch menu to navigate to

the list.
C. Click the LIST tab to open the toolbar.

D. Click the Open with Access icon in the Connect & Export region on the
List tab toolbar.

Depending on the width of your browser screen, you may or may not see
the label text "Open with Access".

© Copyright 2014 Webucator. All rights reserved.Page 386 of 473

Office Integration

EVALUATION COPY 

 
 

Unauthorized Reproduction or Distribution Prohibited



E. Leave the default settings and click the OK button in the
Open in Microsoft Access dialog window.

F. In the Microsoft Access window that opens, double-click the
Favorite Cars link in the Tables window to open it and view the data.
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G. Modify the Bugatti's Top Speed to be "250". Click the Refresh All button
in the Home tab on Access's toolbar.

H. Go back to your browser window and refresh the Favorite Cars page.
The Bugatti item in the browser window should now be the same as what
you changed it to in Access.

I. Try editing the Bugatti's Top Speed in the browser back to "268" and
saving it. Go back to the Access window and click the Refresh All button
in the Home tab and verify that Access now displays "268" for the Bugatti's
Top Speed.

J. Close Access when you are done trying out the editing and synchronizing.
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Conclusion9.4
In this lesson, you have learned:

• How to create a list from and Excel spreadsheet.
• How to update a spreadsheet view of SharePoint list data.
• How to create an alert.
• How to subscribe and view an RSS feed from a SharePoint list.
• How to make a copy of a library in Outlook.
• How to use the Datasheet view.
• How to open and edit a list in Access.
• How to configure and use SharePoint Workspace.

Page 389 of 473Version: 1.2.1. Printed: 2014-09-02.

Office Integration

EVALUATION COPY 

 
 

Unauthorized Reproduction or Distribution Prohibited



7400 E. Orchard Road,  Suite 1450 N
Greenwood Village, Colorado  80111

Ph: 303-302-5280
www.ITCourseware.com

1-38-00145-000-07-18-16

EVALUATION COPY 

 
 

Unauthorized Reproduction or Distribution Prohibited


	SharePoint 2013 Introduction
	SharePoint Versions
	Team Site Layout and Navigation
	Exercise: Team Site Navigation

	SharePoint List Basics
	Creating Apps Using List Templates
	Creating Lists
	List Columns
	Column Validation
	Exercise: Working with Team Site Lists
	Exercise: Create Custom Lists and Columns
	Exercise: Create a SharePoint List with the Import Spreadsheet Template

	Library Basics
	Library Templates
	Creating Libraries
	Managing Documents and Versioning
	Exercise: Working with Team Site Libraries
	Exercise: Creating Libraries
	Exercise: Document Versioning

	Working with Lists and Library Views
	Default Views
	Custom Views
	Exercise: Working with Views
	Exercise: Creating Public and Personal Views

	Working with Sites
	Site Templates
	Creating Sites
	Site Navigation
	Exercise: Creating Team Sites
	Exercise: Creating a Meeting Workspace
	Exercise: Creating a Blog Site

	Page Content
	Wiki Library Pages
	Web Part Pages
	Working with Web Parts
	Exercise: Working with Wiki Pages
	Exercise: Working with Web Part Pages and Web Parts

	Forms Library
	Creating a Forms Library
	Creating InfoPath Forms
	Publishing InfoPath Forms to SharePoint
	Exercise: Creating and Publishing InfoPath Forms

	Site Columns and Content Types
	Site Column Gallery
	Creating Site Columns
	Site Content Type Gallery
	Creating Content Types
	Exercise: Creating and Working with Content Types
	Exercise: Adding a Content Type to a Library

	Office Integration
	Excel Integration
	Outlook Integration
	Access Integration
	Exercise: Excel Integration
	Exercise: Outlook Integration
	Exercise: Access Integration

	Managing SharePoint Site Permissions
	SharePoint Groups
	Assigning Permissions
	Permission Levels
	Permissions Inheritance
	Exercise: Working with SharePoint Permissions

	Participating in User Communities
	Configure User Profiles and My Sites
	Newsfeeds
	People Newsfeeds
	Documents Newsfeed
	Sites Newsfeed
	Tags Newsfeed
	Managing Personal Sites
	Exercise: Managing and Viewing Personal Information and Content

	ITCeBookfrontcover.pdf
	Laying out a Page with HTML5
	Page Structure
	New HTML5 Structural Tags
	Page Simplification
	Exercise: Converting an HTML 4 Page to an HTML5 Page

	HTML5 - How We Got Here
	The Problems HTML 4 Addresses
	The Problems XHTML Addresses
	The New More Flexible Approach of HTML5 - Paving the Cowpaths
	New Features of HTML5
	The HTML5 Spec(s)
	Current State of Browser Support

	Sections and Articles
	The section Tag
	The article Tag
	Exercise: Using section and article Elements
	Outlining
	Exercise: Determining the Outline

	HTML5 Audio and Video
	Supported Media Types
	The audio Element
	The video Element
	Exercise: Video - Multiple Sources
	Accessibility
	Scripting Media Elements
	Exercise: Media API
	Dealing with Non-Supporting Browsers

	HTML5 Forms
	Modernizr
	New Input Types
	HTML5 New Form Attributes
	Some Other New Form Field Attributes
	New Form Elements
	Exercise: An HTML5 Quiz

	HTML5 Web Storage
	Overview of HTML5 Web Storage
	Web Storage
	Exercise: Creating a Quiz Application
	Other Storage Methods

	HTML5 Canvas
	Getting Started with Canvas
	Drawing Lines
	Color and Transparency
	Exercise: Drawing a Sailboat
	Rectangles
	Circles and Arcs
	Exercise: Drawing a Snowman
	Quadratic and Bézier Curves
	Images
	Text
	Exercise: Images and Text

	Integrated APIs
	Offline Application API
	Drag and Drop API





